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No part of this document may be copied or reproduced in any form or by any means without the 
prior written consent of Profit Developers, Inc.  
Profit Developers, Inc. makes no warranties with respect to this documentation and disclaims any 
implied warranty of merchantability or fitness for any particular purpose. Information in this 
document is subject to change without notice. Profit Developers, Inc. assumes no responsibility 
for any errors that may appear in this document.  

   

COPY PROTECTION AND COPYRIGHT  

The Florida Tangible Tax, Georgia Tangible Tax, Florida Sales Tax, Georgia Sales Tax, Florida 
Corporate Income Tax, Payroll Tax Program, 1120, 1120S, 1065, 1041, 1040, 990, and 
Depreciation Programs, available only from Profit Developers, Inc., are not copy-protected. This 
does not mean that you can make unlimited copies of them. These programs are protected by the 
copyright laws that pertain to computer software. It is illegal to make copies of the contents of 
these programs, except for your own backup, without written permission from Profit Developers, 
Inc. Specifically, it is not legal to give a copy to another person.  

   

PROFESSIONAL RESPONSIBILITY  

The user is solely responsible for the accuracy of all tax returns and reports produced by the 
Florida Tangible Tax, Georgia Tangible Tax, Florida Sales Tax, Georgia Sales Tax,, Florida 
Corporate Income Tax Program, Payroll Tax Program, 1120, 1120S, 1065, 1041, 1040, 990, and 
Depreciation Programs. Using the program(s) does not relieve the user of any legal or professional 
obligations regarding the preparation or review of any tax returns of other financial reports.  

 Programs originally conceived, designed, and written by Warren H. Saxon.  

IBM is a registered trademark of 
 International Business Machines Corporation. 
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Profit Developers, Inc. Software License Agreement  

  

This document is a legal agreement between you, the licensee, and Saxon Tax Software, Inc. (SAXTAX). By using this program, 
you agree to become bound by the terms of the agreement. If you do not agree to the terms of this agreement, promptly return all 
software and any other items that are part of this product with your proof of purchase, to SAXTAX and any monies you paid for its 
purchase will be refunded.  

License: In consideration of payment of the license fee, which is included in the purchase price, SAXTAX grants you a non-
exclusive, non-transferable right, without the right to sublicense, to use this copy of SAXTAX software in a single business 
location. The software covered by this license includes and is limited to all SAXTAX Programs, all user manuals, and other written 
materials provided to you by SAXTAX in connection the program(s), and all enhancements, modifications, and updates to the 
program(s), manuals, and other written materials as may subsequently be provided to you by SAXTAX. SAXTAX reserves all 
rights not expressly granted, and retains title and ownership of the software, including all subsequent copies in any media.  

Permitted Uses: This software and accompanying written materials is copyrighted. You may use the software on any number of 
computers at a single location. If you wish to use the software at more than one location, you must obtain a multi-location license 
for each location. You may copy the software for backup purposes only. All other copying of the software or written materials is 
expressly prohibited.  

Limited Warranty: If you are not completely satisfied with the software, you may return it to SAXTAX within 30 days from the 
date of receipt for a complete refund. THE FOREGOING WARRANTY IS THE ONLY WARRANTY MADE WITH RESPECT 
TO THE USE AND PERFORMANCE OF THE SOFTWARE AND IS A LIMITED WARRANTY. SAXTAX EXPRESSLY 
DISCLAIMS ANY AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. SAXTAX 
DOES NOT WARRANT THAT THE SOFTWARE WILL OPERATE OR FUNCTION PROPERLY ON YOUR PARTICULAR 
COMPUTER, THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT 
THE SOFTWARE WILL CONFORM TO ITS PERFORMANCE SPECIFICATIONS. SAXTAX MAKES NO 
REPRESENTATIONS OR WARRANTIES AS TO DATES OF DELIVERY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE, YOU SHALL ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICE, REPAIR AND CORRECTION.  

You understand and agree that you are solely responsible for: (1) defects arising from acts of non-licensed personnel, your 
computer hardware, misuse, theft, vandalism, fire, water, acts of God or other peril; (2) the installation, use, and results obtained 
from the software; and (3) the content, calculations and accuracy of all reports and tax returns prepared in whole or in part by 
using the software. You understand and agree that using the software does not relieve you of any professional or legal obligation 
concerning the preparation or review of financial reports or tax returns.  

SAXTAX Sales Tax Program: You further understand that if you use the SAXTAX Sales Tax Program for the electronic 
filing of your Florida Sales Tax return:  (1) You hereby authorize SAXTAX to receive information from the Florida 
Department of Revenue regarding your Sales Tax efile obligations and transmissions; and (2) When you use SAXTAX to 
file through the Internet, your sales tax data will be transmitted to SAXTAX for retransmission to the Florida Department 
of Revenue.  SAXTAX agrees that it will keep all information received under this paragraph confidential. 
 

Limitation of Remedies: SAXTAX’S LIABILITY FOR ANY REASON AND UPON ANY CAUSE OF ACTION 
WHATSOEVER AND YOUR EXCLUSIVE REMEDY SHALL BE LIMITED TO, in the absence of accident, abuse or 
misapplication, the return of payment to you of the purchase price of the program(s) or the replacement of any CD, on which the 
software is distributed, that is not free from defects in materials and workmanship under normal use and service for a period of 90 
days from date of purchase. IN NO EVENT SHALL SAXTAX BE LIABLE TO YOU OR ANY THIRD PARTY, INCLUDING 
BUT NOT LIMITED TO USERS, FOR ANY DIRECT, CONSEQUENTIAL, SPECIAL, PUNITIVE OR INCIDENTAL 
DAMAGES INCLUDING, BUT NOT LIMITED TO, LOST PROFITS OR OTHER ECONOMIC LOSS (WHETHER ARISING 
FROM BREACH OF CONTRACT, TORT, STRICT LIABILITY OR OTHERWISE) ARISING OUT OF THE USE OR 
INABILITY TO USE SUCH SOFTWARE EVEN IF SAXTAX HAS BEEN APPRISED OF THE LIKELIHOOD OF SUCH 
DAMAGES OCCURRING. 
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INTRODUCTION 

Welcome to SAXTAX 

SAXTAX programs provide easy data entry, screens which closely resemble the actual 
tax forms, year-to-year client information transfer, customized transmittal letters and 
client bills, customized footnotes, on-screen review of returns, a pop-up calculator, the 
"tickler" due date monitor, and clear Program Help screens. And, of course, we provide 
unlimited toll-free technical support.  

How to Use This Manual 

This manual explains how to install and start your SAXTAX Programs. It also shows you 
how to start the SAXTAX Program Manager and the tax return programs and explains 
the various menu items. Frequently Asked Questions and Technical Help information are 
provided for additional assistance. Important notes are highlighted in shaded boxes. 
Please read these carefully.  

Names for buttons, programs, screens, dialogue boxes, tools, menus, keyboard keys, files, 
directories, and cross-references are provided in bold throughout this manual.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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INSTALLING YOUR SAXTAX PROGRAM 

What You Need 

The following are the minimum requirements to run your SAXTAX program:  

 IBM or compatible PC with Windows 2000 or greater  

 512 MB of RAM 
 

Note: Program performance is greatly enhanced when using a Pentium level processor 
and at least 512 MB of RAM. 

 
 Windows 2000 / XP / NT / Windows Vista/ Windows 7 

 Hard Drive space requirements depend upon the programs installed.  
 

 To print forms suitable for filing, a Hewlett-Packard or fully compatible laser 
printer is required. 
 

Note: A Hewlett-Packard Laser 4+ or newer printer is recommended. 

 

Installing from a CD 

1. Insert the CD into the CD drive.  Setup should run automatically 

Note:  If the CD does not run automatically, click on the Windows Start Menu and 
select Run.  Type the CD Drive letter followed by :\Setup.  (For example, type 
E:\Setup if your CD Drive is E.)  Then press OK. 

 

2. Follow the on screen prompts.  When you are asked to enter a product code, enter 
the code you have been provided.  Setup will install program files to the 
C:\FLINT directory.  Use the Browse button to change the default. 

3. After the program files are copied to your system and installation is complete, 
you will be returned to your Windows desktop. 
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Installing to the Proper Directory 

The \FLINT directory is the default installation directory for SAXTAX programs. You 
can install to another directory, but the following should be considered.  

 

Note: Your client data files will always be located under the FLINT directory. 
 

Drive Mapping – If you prefer to install the program files in a directory other 
than FLINT: 

 The SAXTAX program will create a FLINT directory to store client data 
files.  This must be a root directory on any drive. 

 When installing the program files in a different directory, Windows drive 
mapping may be used.  For example, to install to the C:\Apps directory, 
map this as the H: drive.  Then install SAXTAX to the H:\FLINT 
directory.  The installation program will create the \FLINT directory. 

Setup Data – If you install the program to the same folder or directory as last 
year’s program, your setup data will be unchanged.  Otherwise, or if this is an 
initial installation, you will have to enter setup data on the following screens: 

 Preparer’s (Firm) Information 

 Client Bill Defaults 

 Network User Information (for users with Network Module only) 

 Client Transmittal Letter Defaults 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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Installing on a Network 

Your SAXTAX programs will operate with most computer network systems using a file 
server environment, including Novell and Microsoft. 

Note: Because of the complexity of networks, the SAXTAX Program Manager with 
Network Module is strongly recommended for using the programs in a networked 
environment. 

 
Program Manager with Network Module is an optional program that makes it easier to 
use SAXTAX programs in a network environment.  The program acts like a librarian, 
automatically checking client files in and out to different users.  The program also allows 
different users to customize their own default settings for preparer (firm) information, 
transmittal letters and client bills. 
 

Note: Program Manager with Network Module ensures that only one person at a 
time works on a client’s returns, which protects the integrity of the client’s data.  
Installation of the programs on individual workstations while using the file server for 
client data storage will not protect the integrity of your client files. 

 
Network Installation - You can install from a workstation or from the server itself.  Be 
sure that all workstations have identical drive mapping to the server.  If you have any 
concerns regarding the mapping, please consult your network administrator or have the 
administrator call us.  

Program shortcuts and uninstall support will be created on the installation computer. On 
each additional workstation, create a Windows Desktop shortcut “pointing” to the file 
SAXTAX12.EXE on the server. Refer to Starting the Program Manager on page 6 for 
more information.  

 
 

 
 
 
 
 
 
 
 
 
 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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STARTING YOUR SAXTAX PROGRAM 

Starting the Program Manager 

The Program Manager Installation Setup will automatically create two shortcuts in the 
SAXTAX Folder under Start, Programs.  

 The SAXTAX 2012 Shortcut will run your SAXTAX program. 

 The shortcuts under the Program Help folder will access the program help 
without actually running the program. 

 
The Program Manager Installation Setup will also create a Windows Desktop 
shortcut to run the program.  Perform the following steps for any computer or 
workstation if you need to create a desktop shortcut. 

1. Using your mouse, point to a blank spot on your desktop and right click. 
2. From the dropdown list, select New, then Shortcut 
3. In the command line box, enter SAXTAX12.EXE and its path.  For example, 

C:\FLINT\SAXTAX12.EXE.  Click Next to continue. 
4. Enter the name of the shortcut (example: SAXTAX 2012). 
5. Click Finish.  The shortcut should now be on the desktop. 

 
To run SAXTAX, click the SAXTAX desktop shortcut or, click the SAXTAX 2012 
shortcut (under Start, Programs, SAXTAX). At the introduction screen, press any key 
or click to continue. The Program Manager Screen will appear. If this is the first time 
you are running the program after installation, the Program Year should be set to ’12. 
Also, when you use Program Manager for the first time, you will see an introductory 
screen to help guide you through the initial setup steps. You will only see this 
introductory screen during the initial setup.  
 

Note: Program Manager with Network Module users must enter their user ID (or 
they can use the drop down to select a user ID.  You must sign in as “MGR” to access 
SAXTAX network management functions. 
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Using Program Help 

Program Help 

Program Help is provided for each of the SAXTAX programs, including the Program 
Manager.  Use the F1 key to access Program Help for any screen from anywhere in the 
program.  Program Help can also be accessed from each program’s Help Menu or by 
pressing the Help button found on many screens. 

Help for each program contains an Overview section and a Menu Items section. 

Use the overview section to get a general understanding of how the program works.  This 
is especially helpful for new users of the program, or for previous users starting a new 
year. 

From the main screen of each SAXTAX program 

Click the Help Menu 

Select Contents and click Overview to expand the 
topics. 

 

 

Other more detailed help is arranged by Menu Item. You can get 
help for all the menu items by opening the Menu Items book in 
Contents, or by going to any of the menu items in the program and 
pressing the F1 key. 

 

Field and Forms Instructions Help 

 

You can easily access field help and IRS Forms Instructions (for federal 
returns) and DOR Instructions (for state returns) from any field. Move 
your mouse pointer to any tax return input field.  Click the right mouse 
button and select Help for SAXTAX program help, or Instructions for 
Forms Instructions. 
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USING THE PROGRAM MANAGER 

Understanding the Program Manager 

The Program Manager Screen is the “Home Base” for all SAXTAX Program activities. 
Use the Program Manager to set up all activities concerning clients and program utilities.  
 

 

Program Manager screen 

From this screen you can: 
 View Client List in a specific drive, 

directory and program year. 
 Show Client List by Entity. 
 Sort Client List by Client Name, 

Type or Number. 
 Use Find to locate any client 
 See “quick view” client information 
 Use Tools, Menus, and buttons to 

access all Program Manager 
functions 

 See the current User ID (Network 
Module only) 

 Access Network Management 
functions (Network Module only) 

 

 

Note: After setting up client information, a tax return is prepared by selecting one 
client, then clicking the prepare return button.  You may also select a tax return by 
pressing the tool bar buttons right underneath the program menus. 

 
The Program Manager Screen provides lots of information.  With a quick glance you 
can see: 

 The active drive and directory for client data files, 

 The active Program Year, 

 A list of clients in the active directory, 
o Sort the list by client Name, Type or Number. 
o Use Find to quickly locate any client in the list. 

 Demographic information for the currently selected client. 
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From the Program Manager Screen you have access to: 

 Client Permanent File Screen (Client demographics) 

 Tickler Due Date Monitor 

 Client Data Transfer 

 Client Organizer activities for Tangible and 1040 clients 

 Client Transmittal Letter default setup 

 Client Billing default amounts and options 

 Client File Manangement 

 Preparer’s Firm Information 

 Tools including Rebuild Client Directory and Calculator 

 Tax Return Preparation for the selected client 

 Batch Printing of returns and extensions 
 
Use the pull down menus at the top of the screen to access all program functions.  The 
more frequently used functions have a Toolbar button or Push button for fast access.  
Refer to the online help for assistance and tips concerning the use of your SAXTAX 
programs.  Press F1 for help on a specific screen. 
 

Note: The SAXTAX installation program creates a CLI12 directory on your system 
to store your Client Data Files.  You can create additional client data directories/ 
folders on the selected drive by typing the new name into the directory box and 
pressing Enter. 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (772) 337-2921 
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Network Module Users 

Accessing the Network Users Screen 

When you run the SAXTAX Program with the optional Network Manager Module, you 
will be prompted to enter a user name. “MGR” identifies you as the “Network Manager” 
and allows you to go through the initial set-up to establish user names and default settings 
for all users.  
 
You must “Sign in” as MGR to access the Network Users Screen. Then select Network 
Management from the File Menu.  

 
Network Users Screen 

Use this screen to add, delete and 
change network users. 

All current network users appear on 
the list. 

 

 

Setting up Network Users 

The MGR can set up user ids for each of the program’s users on the Network Users 
Screen.  Each user can then customize preparer information, transmittal letters, and client 
bills. 

Note: Users should always log in with their user ID, not as MGR. 

 

Files in use 

When a user selects or “checks out” a client file to work on a return, the client’s name in 
the Program Manager list of clients will be displayed in a red font. This means the client 
will be “locked” to all other users until the client is checked back in.  
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Unlocking Files/Clients (The program won’t let me into the return) 

Occasionally, a program problem or power outage may cause use of the program to be 
abnormally terminated. When the program is terminated, a user may be locked out of the 
client file or directory that was in use at the time the program was terminated.  

 

To unlock client files, your Network Manager (sign in as “MGR”) should: 

 Find the client file in the program manager client list 

 Double click the client and press “Yes” to unlock 

Any user can also unlock a file checked out to himself in the same manner. 

The Network Manager can also unlock a client by pressing the “Unlock Files” button on 
the Network Users Screen. 

 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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Program Manager Tips for New SAXTAX Users 

(If you are a current SAXTAX user, you may want to skip ahead to Program Manager 
Tips for Current SAXTAX Users on page 14.)  

Note: When you use the Program Manager for the first time, you will see an 
introductory screen to help guide you through the initial setup steps. 

Entering Preparer Information 

To enter data about your firm, choose Preparer Information from the Setup menu. 

 

 
Preparer Information Screen 

Enter the information 
concerning your firm.  Data 
will be saved and transferred 
from year to year.  Refer to 
Program Help for detailed 
information. 

 

Viewing or Modifying Client Transmittal Letter Information 

To view or modify client transmittal letter default information, click Setup | Transmittal 
Letters. The default letters are used as a Master letter for each client’s tax return.  The 
letter can be tailored individually for each client, inside the return, and the modifications 
are saved with the client’s return data.  

 
Transmittal Letter Setup Screen 

 Select the tab for the type of 
letter desired. 

 Select the part of the letter 
for viewing. 

 Refer to Program Help for 
detailed information 
concerning the modification 
of letters. 
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Viewing or Modifying Client Billing Information 

To view and modify client billing default information, click Setup | Client Bill.  All data 
will carry to each client’s return – where it can be further modified.  

 

Client Bill Defaults screen 

 

Indicate your billing preference. 
 

 

Enter billing charge for each type 
of return. 
 

Click Help or use F1 for 
additional assistance with this 
screen. 
 

Enter line item descriptions for 
each type of return.  “Variable 
data” insert codes are replaced 
with actual data in the final bill. 

 

You must be logged in as MGR in order to update client bills and apply to all users.  

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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Setting up a New Client 

Click the New Client button to create and enter data about your client. Demographic data 
flows to each tax return. Refer to Program Help (F1 or Help button) for detailed 
information concerning the fields on this screen.  

 

New Client Screen 

You must enter a client 
number.  Use up to 6 
alphanumeric characters.  
The program uses this 
number to name your client 
data files. 
 
Tickler information is used 
to prepare Tickler Due Date 
Monitor Reports. 

 

Modifying Client Demographic Information 

Use the Edit Client Data Screen to change or modify current client data. To access the 
screen, select a client name and click the Edit Client Data button. Changes made on the 
Client Information Screen will flow to the individual tax returns only if the Allow 
Override box is unchecked.  

Preparing a Tax Return 

Note: Set the Program Year to ’12 to prepare 2011 Tangible, F-1120, and 941 returns 
and for 2011 W-2s, 1099’s, 940’s, Depreciation and Federal Tax Returns.  To prepare 
returns for earlier years, adjust the Program Year accordingly.   Each return allows 
you to prepare returns for the current year and 3 prior years. 

 
To prepare a tax return for a client: 

 Select a client from the Program Manager Client List 

 Click the Prepare Return button or the appropriate toolbar button to take you 
into the desired tax return or the Depreciation program.   If you have more than 
one program loaded, the Prepare Return button will prompt you to select which 
return you want to prepare. 

 
Refer to the Program Help in the applicable program for specific instructions for 
preparing different types of returns.  
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Program Manager Tips for Current SAXTAX Users 

You might want to review the activities described in the preceding section as well as the 
following:  

 Client Data Transfer (Rollover from prior year) 

 Print Client Organizers (Tangible and 1040) 

Transferring Client Data 

Your 2010 Client Data Files will automatically be transferred (or rolled over) into the 
2011 directory. However, if you do not see your company/client listed with your year set 
to ’11 in the Program Manager, you should transfer your 2011 data to 2012.  

The SAXTAX Program Manager will transfer appropriate 2011 information (i.e. 
certain schedule descriptions, Depreciation, and carryover values) into your initial 2012 
client files. Your 2011 files will not be affected by the transfer and can be accessed by 
changing the Program Year.  

To transfer data from the most recent year to the current year (2011 to 2012) 

 Set the Program Year to ‘12 

 From the Program Manager Menu, select Activity |Data Transfer.  This screen 
will show you your clients from last year and will allow you to transfer a single 
client, multiple clients and specific return types for those clients which are 
selected. 

 

 
Client Data Transfer Screen 

1. Use the 
drop 
down 
arrows 
to 
indicate 
the 
location 
of prior 
year 
files. 

2. Confirm 
the 
destinati
on for 
the 
current 
year. 

3. Select 
specific 
return 
types if 
you are 
not 
transferr
ing all 
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returns. 

4. Select 
clients 
using 
Shift-
leftclick 
or Ctrl-
leftclick 
or the 
Select 
All 
button. 

5. Press 
the 
Transfer 
Clients 
button. 

 

The transfer process may take a few minutes depending on the number and size of your 
client files.  You can minimize SAXTAX during this process if you need to work in other 
applications. 

Handling Corrupt Client Files 

Note: Occasionally a corrupt 2011 client file might not transfer to 2012.  If this 
happens, the transfer should skip the file and give you an opportunity to print a list of 
those clients which did not transfer. 

 
You have several options for corrupt client files: 

 If you have your clients backed up, you may be able to copy or do a data transfer 
from your backup directory. 

 If it is an old client, transfer client data from 2010 to 2011 and then from 2011 to 
2012. 

 Create the client from scratch in 2012 inputting client information from 
documents you have on file.  This is usually quicker than the option below if you 
are doing a data transfer and most of the fields which need to transfer are 
demographic information. 

 Send the client files (of the corrupt client) to SAXTAX and we will try to repair 
them for you.  Under the Tools Menu, on the Program Manager Screen, is a 
Backup Clients utility which will copy various client files into a single zip file.  
You can then email us, attaching the zip file, or put the zip file on a CD and send 
it to us.  

Printing 1040 or Tangible Organizers 

An Organizer is a printed summary of last year's data that the client (or tax preparer) can 
mark up. It generally makes data entry for the new tax year easier. To print organizers for 
clients you prepared returns for last year; go to Activity | Organizers | Print Client 
Organizers.  You will also see two other options under the Organizers menu, Setup – 
which allows you to customize the organizer letter and Blank Organizers – which prints 
a predefined organizer for clients you have not prepared returns for in the past.  
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Print Client Organizers 

1. Specify the location of 
last year’s client files 

2. Select Organizer Type 

3. Select Client(s) 

4. Press the Print button 

You can also click on the 
Print Selected Forms 
button to select specific 
pages you want to reprint. 
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Updating Last Year’s Information 

If you installed your programs “on top” of last year’s programs, the following data should 
automatically carry over from last year. Click the appropriate Toolbar button to review 
or modify each as desired. 

 Your Firm/Preparer information 

 Client Billing defaults 

 Client Transmittal Letter defaults 

Creating New Clients 

To create new clients go to the Program Manager Screen and click the New Client button 
or the menu combination File | New Client. 

Preparing a Return for a Selected Client 

To prepare a return for a selected client, click the Prepare Return button or click the 
appropriate Toolbar button.  

Note: The first time you access a client that was transferred from last year, the Client 
Information Screen will open to give you an opportunity to review and modify any 
data as necessary. 

 
 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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Using the Menu Items in SAXTAX 

SAXTAX Programs provide a variety of useful Tool Menu, File Menu, Setup Menu, 
and Activity Menu items. Most are available from any SAXTAX program, and some are 
available only through Program Manager. 

The Tools Menu 

Using the Calculator 

The Calculator can be accessed by any program by using the F2 key.  The product or sum 
of the calculation can replace the active field of the return when you press the F2 key or 
the insert key from this screen. 

Using Rebuild Directory 

Rebuild Client Directory is accessed from the Program Manager only and is used to 
rebuild the “index file” that maintains a listing of all of the clients in a directory. Use this 
tool if your client list does not appear on the Program Manager Screen.  

To use the Rebuild feature, indicate the correct program year, client drive, and directory 
on the Program Manager Screen. Access the Rebuild Client Directory from the Tools 
Menu. Review the screen for correctness and click the Rebuild button to continue. The 
program will indicate “Done” when finished rebuilding. If, after using this feature, your 
clients still don’t appear, call SAXTAX Technical Support at (772) 337-2921.  

Backup Client Data 

Occasionally, you may wish to backup your client data as a precaution in the event of 
computer drive failure. To do this, select the Backup Client Data from the Tools menu 
option.  

To backup the client data once the dialog appears: 

Verify that the directory name displayed is the directory that you want to backup. If the 
directory is not the correct directory, click on the drop-down arrow to select the correct 
drive and directory, and then choose which client(s) to backup using the shift-leftclick or 
ctrl-leftclick keyboard and mouse combination or press the ”Select All" to select all 
clients listed.  

Verify that the ‘Save As’ drive, directory and filename are correct. Press the "Create Zip 
File" button. The program compresses the client data. When the process is complete, a 
box is displayed with the number of files added. Press the Okay button and then the Close 
button to return to the Program Manager Screen. If you experience any problems during 
this process, call SAXTAX at (772) 337-2921.  
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Restore Client Data 

To restore the client data:  

From the Tools menu, select the Restore Clients menu item. The Restore Clients dialog 
box is displayed.  

Select the directory that you want to restore from. If the directory is not the correct 
directory, click on the magnifying glass to select the correct drive and directory, and then 
choose which file(s) to restore or press the Select All button to select all files listed.  

Verify that the ‘Restore To’ drive and directory are correct.  

Press the Restore button. The program restores the client data. When the process is 
complete, a box is displayed with the number of files extracted.  

Press the Okay button and then the Close button to return to the Program Manager screen. 
If you experience any problems during this process, call SAXTAX at (772) 337-2921. 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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The File Menu 

Using Client Management 

Use the Client Management utility to copy or move client files from one drive and 
directory to another, or to delete client files. Use this utility to back up client files on a 
floppy disk or network drive. Access Client Management from the Program Manager 
Screen File Menu or click the Client Management button.  

 

Client Management Screen 

 

 

One panel on the screen represents the source and one the target. Client data files can be 
copied or moved in either direction. 

1. Use the drop down arrows to select the source drive and directory in one panel, 
and the destination drive and directory in the other panel. 

2. Select the desired client files and, using the mouse, drag the files from the source 
panel to the destination panel.  The buttons between the panels can also be used 
for this process instead of dragging. 

 

Note: The Client Management Screen remembers the last drive and directory you 
accessed on the right half of the screen and reads clients from that device when you 
initially come to this screen.  Do not leave this screen with a removable drive 
selected (floppy, jump drive, external hard drive, etc.).   If the drive requires a disk 
and it is removed or the drive is not connected, this screen may generate obscure 
errors. 
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The Setup Menu 

Options 

Several options can be set using this screen. 

 

Return Options Screen 

Click the Help button for 
detailed information 
concerning these option 
items. 

 

Printer 

SAXTAX allows you to specify a default printer for printing your tax returns. This is 
useful if you always want to print your returns to a printer that is not your Windows 
default printer.  

 
Default Printer Screen 

Because of the wide variety of 
laser printers, you might require 
special printer driver settings for 
SAXTAX printing.  Use this 
screen to select a specific printer 
or driver for SAXTAX printing. 

 

Refer to Program Help or to the SAXTAX Web site (www.saxtax.com) for possible 
printer settings and solutions to printing problems.  
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The Activity Menu 

Printing Labels and Lists 

Use this feature to print mailing labels and client management lists. Refer to the 
Program Help for detailed information concerning the printing of Client Labels and 
Lists.  

Using the Tickler Due Date Monitor 

This feature is very helpful for planning your firm’s activities. Data for developing 
Tickler Reports is entered on the Client Permanent Files Screen. (Select the client and 
click the Permanent File button to view and modify this data).  

 

Due Date Tickler Screen 

1. Specify the desired time 
period 

2. Specify the client drive and 
directories 

3. Specify Return Types 

4. Specify Responsibility 

5. Click Preview to view a list 
of return due dates and last 
printed dates 

6. Press the Print button for a 
hardcopy. 

 

 
 
 
 
 
 
 
 
 
 
 
 

For Technical Assistance, call SAXTAX at (772) 337-2921  
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USING THE TAX RETURN PROGRAMS 

Now that you have installed the programs and set up your clients, you are ready to use 
SAXTAX to prepare tax returns.  

Note: Please refer to the Program Help located in each of the SAXTAX programs for 
further information. 

 

Preparing a Client’s Tax Return 

Note: Before you can access a client’s tax return, be sure that you select the desired 
drive, directory and program year from the drop down lists at the top of the Program 
Manager Screen. 

 
Access each tax return from the Program Manager Screen. 

1. Select the desired client. 
2. Use the Prepare Return button or the appropriate tool button to open the desired 

tax program.  Prepare return is also listed under the File Menu. 
 
Once you are inside the return, the left pane shows you a list of all the forms that the 
program supports.  (In the 1040 we also support the 8283 which can be accessed from 
Schedule A.)  (In Depreciation, use the Forms Menu.)  Above the forms are three buttons, 
side by side.  When the first button is “down”, you can see the forms we support.  When 
the second button is “down” you can see the forms you have already entered data for on 
this return.  When the third button is “down” you can see a “Print Preview” version of the 
return. 
 
Data Entry – All data is entered on “fill in the blank” screens.  If you are having trouble 
accessing a field, it may be a calculated field or a field that will only allow you to access 
a schedule (by pressing the * key).  In other cases, the field may be grayed out because 
the form does not require data entry for specific lines.  Use the tab key to tab through the 
applicable fields for data and schedule entry. 

Pull-down menus – All program functions can be accessed through the menus at the top 
of the screen. 

Program Help – Each of the SAXTAX programs, including the Program Manager, 
provides Help which can be accessed by pressing the F1 key, pressing the Help button 
(found on many dialogs), or by pressing Help | This Screen from the pull-down menus.  
For IRS or DOR Instructions help, right click on a data entry field and select 
Instructions. 

Toolbar buttons – While we think the pictures on our tool buttons are self-explanatory, 
it may initially be confusing to some.  To understand the function of a tool button, put 
your mouse “over” the button and wait.  A short explanation of the tool’s function will 
appear. 

Detail entry – Click on the magnifying glass, next to data entry fields, or press the * key 
in order to access information required to support the form’s data. 
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Reviewing Tax Returns 

Depreciation Program – To print or review your returns, click the printer button on the 
toolbar or File | Print Preview.  This will bring you to another screen where you can 
select the different reports and forms (see the tabs just below the tool buttons) that you 
want to print or review. 

Additional Forms Program – The print button only prints and previews the current 
form you are entering information on.  It does not print all of the forms you have 
information on. 

All other programs – To review your clients returns before printing, click the rightmost 
button of the 3 buttons above the forms list. 

Printing Tax Returns 

Tax returns are printed from within each tax return program. A Hewlett-Packard Laser 
Printer or 100% HP compatible laser printer is required to print approved forms (see 
note).  All the tax forms are approved by the appropriate agencies for filing. 

Note: The actual printing process is a function of Windows and your printer driver 
software.  While all testing of the programs is done on HP laser printers, you may also 
have successful results on high quality inkjet and bubble jet printers.  But we can 
guarantee the results only for HP laser (or fully compatible) printers. 

 
Printing the Full Return – Click the Printer button on the program toolbar to print the 
entire return.  Before the return prints, you will be prompted for various copies of 
transmittal letters (if they are enabled in the Program Manager), client bills (if the client 
billing screen has “prepare bill for client” checked), the return, K-1’s, and other 
applicable forms or letters.  

 
Print Return 

 Confirm the print date. 

 Enter the number of copies 
desired. 

 Use the Setup button to change 
the printer and printer 
parameters.  This is a standard 
Windows interface. 

 Save Profile saves “number of 
copies” as your standard 
configuration for this screen. 

 

Printing Selected Pages Only – From the program menu select File | Print Forms or 
from the toolbar select the Print Selected Forms (multiple pages) button.  There is also a 
button on the toolbar, when you are previewing, to print a single page. 
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Batch Printing 

You can batch print Federal and State tax returns or extensions. Select the clients you 
want to batch on the Program Manager screen. Select multiple clients by clicking on a 
client, and holding the shift key to select a range of clients or hold the CTRL key to select 
various clients.  

Returns 

Once you have selected the clients you want to print, press Batch Print. From the dialog, 
select the type of return or returns you want to print (i.e. Tangible, 1120, etc.). If the 
return is an S Corporation or Partnership, a copy of the K-1’s will print with the return. If 
you want to print a copy of the K-1’s and letters to send to the shareholders or partners, 
you must also select “K-1’s and K-1 letters”. Use the same procedure to select multiple 
items in the batch “Print dialog box” as you would to select multiple clients in the 
Program Manager above.  

Extensions 

If you need extensions to print with an explanation (or any other information), you need 
to make sure this information is entered inside the return.  If no program information has 
been entered, the extension or extension letter will print with only the Name, EIN/SSN 
and address.  Refer to the instructions of the return for extension filing requirements. 

Tangible Returns with Multiple Locations 

You can batch print returns with multiple locations or you can select individual locations 
to print. Use the above procedures to select your Tangible clients in the program manager 
screen. After clicking on the batch print button, select either “Tangible- All locations” or 
“Tangible- Selected locations”. When you choose “Tangible- Selected locations”, a 
dialog box will appear and you can then choose the locations you want to print. If you 
have multiple clients that have locations, the dialog box to select the location will appear  
just before specified client’s return starts to print.  

Saving Client Data 

Your client data is saved when you print a return or exit the return in the normal 
manner. However, the program does not have an auto-save feature, that saves after a 
certain amount of time, so we suggest that you manually save data periodically to prevent 
data loss due to computer problems or power outages. To periodically save data, click the 
Save tool.  
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FREQUENTLY ASKED QUESTIONS 

Following are some common questions heard from our customers. We also maintain an 
updated list of FAQ’s on our web site: www.saxtax.com. 

"What is the best way to transfer my clients between computers?"  

It's best to use the Client Management Screen in the SAXTAX Program Manager to 
move, copy, or delete client files between networked computers. For “stand alone” 
computers, use the Client Management Screen to copy or move files to and from a 
diskette. This will ensure the movement of all the files and will prevent the index file 
from being corrupted.  

"How can I 'backup' my client files?"  

From the Program Manager, use the Backup Client Data on the Tools Menu. You can 
also use the Restore option under the Tools Menu to unzip your client files back to the 
original location.  

"I need to input a great deal of information into a Program. In case of a 
power outage or other interruption, how can I make sure I won't lose any of 
the data I have entered before I am finished?"  
Periodically save your data by clicking the Save tool or File | Save.  

"Can I enter a negative amount in a field that normally won't allow it?"  

With the cursor on that field, press the F2 key to bring up the calculator. Enter figures 
into the calculator so that the result is the negative amount you want. Press the F2 key 
again to enter or "paste" that amount in the field.  

"Do I need to keep last year's version of the program on my computer?"  

No. Your current version of SAXTAX can be set to do returns for up to three prior years 
in addition to the current year.  

Change the Program Year from the Program Manager Screen (upper right of the 
screen). If you need earlier years, you should contact SAXTAX Technical Support for 
assistance.  

"My clients are gone! What can I do?"  

The client files are probably still on your disk, but you may have changed the directory or 
year on the Program Manager screen. First make sure the Program Manager is pointing to 
the right drive, directory and year for your clients.  

If you still cannot locate them, the client index file may have been corrupted and needs to 
be rebuilt. From the Program Manager Tools Menu, select Rebuild Client Directory. 
Verify the location of client files and click the Rebuild Directory button. You should 
receive the "Done" message when the process is complete. Return to the Program 
Manager and the clients should be listed. Call SAXTAX if you continue to have 
problems.   
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TECHNICAL HELP 

If you need assistance for a problem that you cannot resolve, please check the following 
before calling us: 

1. Have you checked the program help and/or the instructions?  

2. Does the problem occur on more than one client’s return? 

3. If you have SAXTAX loaded on more than one machine, can you reproduce the 
problem on another machine? 

4. Can the problem be duplicated?  Sometimes exiting the program and going into the 
same return will fix the problem.  Sometimes only a certain sequence of events will 
cause a problem.  The quicker we can reproduce the problem, the quicker we can fix 
the problem and update the program. 

5. If the problem affects a printed return, do you have a printed copy you can fax us? 

6. Are you at your computer?  Many problems are difficult to diagnose unless we can 
work with you at your computer. 

Note: Please use our toll free technical support (772-337-2921).  If there is a problem 
with your program it will be corrected. 

 
 

Phone: (772) 337 – 2921      FAX: (877) 721 – 7249 

Email: info@saxtax.com 

Website: www.saxtax.com 

 

 

 

 
For Technical Assistance, call SAXTAX at (772) 337-2921  

 

 
 


